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C yero HayHem

With what we shall begin




B Internet Explorer.

IN Internet Explorer.




[1pn 3anycke d6poy3epa, B
3aBYICUMOCTU OT

YCTaHOBTIEHHOW BEPCUMN,

k) OObIYHO 3arpy»xaeTcs

¥ HayanbHasa cTpaHuua Microsoft

1 wnn Web-cTpaHuua, kotopasi

|~ { comepxuTca Ha KeCTKOM aucke
0 KOMMblOTEpa.

/ 4 | At start of a browser, depending on the established version, initial page
| Microsoft or Web-page which contains on a hard disk of a computer is
usually loaded.




Bbl MOXeTe yKkasaTb Apyryto

} {  HayanbHYyl CTpaHWULYy N

, -] OoTKasaTbCs OT 3arpy3kn Kakom-

177 nnbo cTpaHuLbl Mpu 3anycke
rnporpammbi.

: 4} | You can specify other initial page or refuse loading any page at start of
| the program.




(3arpy3ka Ha4YanbHOW
-4 CTpaHuULbl, XpaHsLlencs Ha
| oncke, npomcxoauT [OCTATOYHO
Lo BbICTPO, NO3TOMY Mb!
npeanoyYnTaem 3TOT BapuaHT
3arpyske nyctou ctpaHuupbl.)

(Loading the initial page stored on a disk, occurs quickly enough,
therefore we prefer this variant to loading of empty page.)




YTOObI N3AMEHUTL CTPaHULY,
.} nognexatlyto 3arpysKke rnpm
Y. ¥ 3anycke 6poy3epa, BbINOMHUTE
cnegyoLme Lwarm.

To change the page which is a subject loading at start of a browser,
execute following steps.
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1. OTObOpasnTe Ha aKpaHe

Web-cTpaHuLy, KoTopyio Bbl

XoTenu bbl UCNONb30BaTh B
KayecTBe Ha4yallbHOW.

Display on the screen Web-page which you would like to use as
initial.



Hanpumep, Bbl MOrnun Obl
Ha4yaTb CO CTpaHuULbl Yandex,
mnn KomnbroTEPHOE
n3pgartenbcTBO "HduanekTnka”
(www.dialektika.com).

For example, you could begin with page Yandex or Computer
publishing house " Dialectics " (www.dialektika.com).




2. Bblbepute KomaHOy MeHIo
CepBuc=>CpoucrtBa

{1 06o3pesatens (Tools*Internet

Options) vnin Bug *
v .4 CBoncrtBea 0603peBaTen$| (View

Internet Options

General | Security | Privacy | Content | Connections || Programs | Advanced

Home page

&Y hange which page t f home pag
Rl - H D //www . google. com

[ Use Cument J l Use Default J l UUse Blank J

2. Choose a command of the menu Service => Properties of an
observer (Tools*Internet Options) or the Kind of Property of an
observer (View Internet Options).



Bbibop koMaHAObl 3aBUCUT OT
Bepcun bpoysepa,
YCTAHOBITEHHOIO Ha BalUEM

W W N Y . V. . N.W._.N __

Internet Options

General | Security | Privacy | Content | Connections || Programs | Advanced

Home page

‘*ﬁ You can change which page to use for your home page.
= YRS to: //www . google. com)

LUse QurrentJ que Default J L UUse Blank J

The choice of a command depends on the version of the browser
established on your computer.



3. Bbibepute Bknaaky Obwme
(General).

| Internet Options @

General | Security | Privacy | Content | Connections || Programs | Advanced

Home page
rﬁ You can change which page to use for your home page.

Address: e google

[ UseCument | | Use Defautt | [ Use Blank |

3. Choose tab General (General).




) -4 Ha camom pgene aTa Bknaaka,
I~ 1 ckopee Bcero, yxe BblbpaHa, HO
-4 Mbl HaOMMHaem 06 3TOM Ha
TOT Clny4vau, ecrnu Bbl 3aX0TUTE
NOCMOTPETb, Kakne napameTpsbl
HACTPOWKN coaeprKaTca B
OpYrnx BKnagkax.

/ 4 | Actually this tab, most likely, is already chosen, but we remind of it if
| you want to look, what parameters of adjustment contain in others tab.




4. B noapasngene [HomallHAA
ctpaHuua (Home Page)
LLIENIKHMTE Ha_KHOTKe

Internet Options

General | Security | Privacy || Content | Connections || Programs || Advanced

Home page

ﬁY hange which page t f home pag
= PN R - //www .google. com)

Ll_lse QurrentJ [ Use Default J L Use Blank J

4. In sub item the Homepage (Home Page) click on the button




B none Agpec noasutca URL
TEKYLLUEN CTPaHULLbI.

In a field the Address will appear URL current page.




{4 Yro6bI Npu 3arpyske 6poysepa

.} He 3arpyxarnucb HUKaKue

.4 CTpaHULbl, LUENKHWUTE Ha KHOMKe
"1 C nyctoin (Use Blank).

: 4} | That at loading a browser no pages were loaded, click on the button

With empty (Use Blank).



5. LenkHuTe Ha kHonke OK.

5. Click on button OK.




BbibnpanTte HavyanbHyto
CTpaHuLy, coaep Kallyto He
O4YeHb MHOIO N300pPaXKeHUMN.

Choose the initial page containing not so of many images.




4 Ha4duHasa c Web-cTpaHuubil,

}- { KoTOpas 3arpyxaetcs buicTpee,

, -1 1nu 6e3 HayanbHoO CTPaHNLbI

477 BoOGLLe, Bbl BbICTPEE CMOXKETE
i NnpUCTYNUTL K paboTe.

/ 4’ | Since Web-page which is loaded more quickly, or without initial page in
| general, you can start to work more quickly.




XnagHOKpPOBHbIU TpyAsra no
MMEeHMU KoLl

Cool labor named a cache




Korga bpoy3ep n3Bnekaer
HY>XHYIO BaM CTpaHuLy, OH
COXPaHAET ee Ha AUCKe

KOMMNbOTEpPA.

When the browser takes the page necessary to you, it keeps it on a
disk of a computer.




i+ Ecnn Bbl 3axoTnTe eLle pas
{-{yBnOeTb Ty e camyto CTpaHuLy
| NATb MUHYT crycTa, NporpammMa
Y. ¥ He ByneT 3arpyxaTb ee CHOBA -
OHa BOCMOMNb3yeTCH
MMELLENCH Konmen.

If you want to see once again the same page five minutes later, the
program will not load it again - it will take advantage of an available

copy.




[ lpOCTPaHCTBO Ha >KECTKOM
OucKe, NCronb3yemoe BalluMm
bpoy3epom Ans XpaHEeHUS
CTpaHuL, Ha3biBaeTCcHa KoLl (OT
dopaHuy3cKkoro cachet-

npaTaThb).

/ 4’ i The space on a hard disk, used by your browser for storage of pages,
| refers to a cache (from French cachet-to hide).




Uem Bbonblue mecTa Bbl
oTBedeTe bpoysepy noa Kal,
TeM ObICTpee CTpaHuubl byayT
NosABNATLCA Ha 9KpaHe Npu nx

NMOBTOPHOM BbI30BE.

The more you will allocate places to a browser under a cache, the
more quickly pages will appear on the screen by their repeated call.




Visit history sites while off line




B Internet Explorer.

IN Internet Explorer.




UTOoObI 3aaaTb pa3mMep Kalla B
Internet Explorer, BbinonHuTe
cnenyrollne OencTeug.

To set the size of a cache in Internet Explorer, execute following
actions.




1. Bbibepute B MEHIO
KOMaHAdy Tools"lnternet

1. Choose in the menu command Tools*Internet Options =>
Properties




Internet Options

General | Security || Privacy || Content || Connections || Programs | Advanced

Home page
FE! You can change which page to use for your home page.

o obo3peBaTens

[ Use Cumrent ] [ lUse Default ][ lUse Blank

Temporary Intemet files
7 j; Pages you view on the Intemet are stored in a special folder M l I M
§ e

for quick viewing later.

[Delete Cooki_es...] [ Delete Files... ] [ Settings...

View”Internet

—

h The History folder contains links to pages you've visited, for

quick access to recently viewed pages.

|
Days to keep pages in history: 20 55 pt I o n S

[ Colors... ] [ Fonts... ] [ Languages... ] [Accgssibilit',".‘]

[ OK ][ Cancel ]

Observe or View”Internet Options




4~ { 2. lWenkHnte Ha Bknagke
-1 General (O6wwme), ecrniv oHa Ao
CUX NMop He BbibpaHa.

2. Click on tab General (General) if it till now is not chosen.




)l )2 3. B nogpasnene
, v Internet Options T e m p o ra ry

General | Security || Privacy || Content || Connections || Programs | Advanced

Home page

[ ]
[ You can change which page to use for your home page. I n te r n et I I e s
‘ % I
LT

Lt //www. google. com)

[ UseCurent | [ Use Defautt | [ Use Blank (BpeMeH H ble

Temporary Intemet files

7 g Pages you view on the Intemet are stored in a special folder

:f_} 3 ick viewing | 1/
| @ Y forquick viewing later. ¢a Mn bl

[Delete Cookies...] [ Delete Files... ] [ Settings...

WHTepHeTa)
Days to keep pages in history: |20 % LLlleJ-I KH MTe Ha
| coors.. || Fomts.. || Languages.. | | Accessbilty.. | -
KHOMKe Settings
(MapameTpbl).

3. In sub item Temporary Internet Files (Time files of the Internet)
click on button Settings (Parameters).

[ OK ][ Cancel ]




7 i; Check for newer versions of stored pages:
l:‘ e

(O Every visit to the page O T K p O eT C ﬂ

\\ Every time you start Internet Explorer

.................................

...........................

[ManoroBoe OKHO

Temparary Internet files folder
| |
Current location:  C:\Documents and Settings\Mark S.
Pulver\Local Settings\Temporary e I
Internet Files\
Amount of disk space to use:
== | (MapameTpsbl) C
[ Move Folder... ] [ View Files... ][ View Objects... J M H | M m

KoLleE.

[ OK H Cancel J

Dialogue window Settings (Parameters) with the information on a
cache will open.




0+ 4. lllenkHnTe Ha NoON3yHke
|-1 Amount of disk space to use
N nepeBeamnTe ero B

" % NorioxeHne, COOTBETCTBYIOLLEE
e npnbnuanTensHo 10%

.EI IAciNnpNrn. NNNCTNAHCTBA.

Amount of disk space to use:

1788 & | MB

/ 4} | 4. Click on toddler Amount of disk space to use and translate it in
| the position corresponding approximately of 10 % of disk space.




Ecnn y Bac Ha gucke MHOro
cBOOOOHOro Mecrta, CTOUT
yBennunTb 3Ty umdpy oo 20%.

If at you on a disk it is a lot of empty seat, it is necessary to increase
this figure up to 20 %.




Ecnun e y Bac Ha gucke
HexBaTKa cBOOOOHOro MecTa,

YMEHbLUMUTE pa3Mep Kalla Ao
1-2%.

If at you on a disk shortage of an empty seat, reduce the size of a
cache up to 1-2 %.




B none cnpaBa OT NON3yHKa
OyoeT ykasaH BblIOpaHHbIN
oObeM ONCKOBOIO

NPOCTPaHCTBA.

Amount of disk space to use:

J 1788 5| MB
In a floor to the right of a toddler the chosen volume of disk space will
be specified.




5. [Bakobl LLENKHUTE Ha
kHornke OK.

5. Click on button OK Twice.
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Web-cTpanuuam -6onbuwe
Mecma

Web-pages have more than place




B BepxHen YyacTn OKHa
Opoy3epa pacrnonaraeTca Tak
MHOI0 BCEBO3MOXHbIX KHOMOK,
3HA4YKOB U Mosien, YTo MecTa

CTPpaHWLbl OCTA€TCA HE TAK YX
MHOIO.

In the top part of a window of a browser every possible buttons,
badges and fields settle down so many, that places for display of the
Web-page remains not too much.




BOT He CKONMbLKO NPUEMOB,
NO3BONAKLLNX YBENMUYUTL
NPOCTPAHCTBO 3KpaHa,
npegHasHa4vyeHHoe Ang
oTobpaxeHunss Web-ctpaHuu.

/ 4} | Here not how many the receptions, allowing to increase the space of
| the screen intended for display of Web-pages.




B Internet Explorer nnowagb
nns otoopaxeHms Web-

1 cTpaHuu Ha 3KpaHe MOXHO

477 yBENUUMTL, CKpbIBasi HEKOTOPbIE

1 nmaHenu MHCTPYMEHTOB.

| AL A
(P =

In Internet Explorer the area for display of Web-pages to the screen
can be increased, hiding some panels of tools.



Ecnn Ha 3KkpaHe NpUcyTCTBYeET
.. ¢ naHenb CcbikK (00bI4HO OHa
|- { pacnonaraetcsa cnpasa unu nog
-\ agpecHON CTPOKON), CKponTe

|  => [NaHenu UHCTPYMEHTOBKU =>
|~ 4 Ccbinkm (View Toolbars”Links).
A 4 If on the screen there is a panel of the Link (usually it settles down on

the right or under address line), hide it, having chosen a command of
the menu the Kind of the Panel nictpymeHtos*Ccbinku (View=>




A YTOObLI BEpHYTL Ha 3KpaH
y, -1 CKPbITbIV 3MNEMEHT, Bblbepute Ty
AN Xe KoMaHay elle pas.

Y../# To return on the screen the latent element, choose the same command
once again.




Bbl cCMOXeTe CKpbITb gpyrue
NnaHenm MHCTPYMEHTOB,
BbIOMpasa pasrnnyHble NyHKTbI
noamMmeHto Bua => [laHenn
MHCTPYMeHTOB (View =>
Toolbars).

/ 4 /W You can hide other panels of tools, choosing various items of submenu
| of tools (View Toolbars).




OgHako He 3abbiBanTe O TOM,
YyTO Ha naHenu CcCbIfKU MOXHO
Pa3MeCTUTb NMUKTOrpammbil

CBOUX NOOUMBIX CTpaHULL

However do not forget that on the panel of the Link it is possible to
place pictograms of the favorite pages



[locneaHune Bepcun Netscape,
Mozilla n Internet Explorer
obnapatoT PyHKUMEN

NOJIHO3KPAHHOIO peXxmnma.

/ 4 /W Last versions Netscape, Mozilla and Internet Explorer possess function
in fullscreen mode .




[lepenT B NOJTHO3KPAHHbLIN
PEXNM MOXXHO C MOMOLLIbIO
knasuwin <kF11>.

To pass in full-screen mode it is possible by means of a key <F11>.




;4 [Mpwn 3TOM rpaHuLibl OKHa, MEHIO

“" { N CTpPOKa COCTOSAHUSA NCHE3HYT, a

/.1 ocTaHyTCs TOMNbLKO NaHenb

MHCTPYMeHTOB U cama \Web-
cTpaHuua.

Thus of border of a window, the menu and a line of a condition will
disappear, and there will be only a panel of tools and Web-page.




UTOObI BEPHYTLCS K
HopManbHOMY BMAOY OKHa
bpoyaepa, CHOBaA HAXXMUTE
knaemwy <F11>.

To return to a normal kind windows of a browser, again press a key
<F11>.




B Internet Explorer nmeetca
OYHKUUNA, KOTOPY Ha3blBaAlOT
pacmsaueaHuem naHersreu
UHcmpymeHmoas. (customize)

In Internet Explorer there is a function which name Customize



;4 UTobbl HAayYMTbCA PacTArMBaTh
o3 naHenn MHCTPYMEHTOB,
HeobXoOMMO HEMHOIO

/ 4’ | To learn to stretch panels of tools, it is necessary to practice a little, but
| all over again they need to be unblocked.




LLlenkH1nTe npaBou KHOMKOW
% MbIlUX Ha cBOOOOHOM MecTe
~~ Y no6on naHenu MHCTPYMEHTOB U
Y BbIBepuTe NyHKT 3akpenuTb
naHenm MHCTDVMEHTOB.

v Standard Buttons
v Address Bar

| Links ~ Customize

v Adobe PDF

.| v Lock the Toolbars
Customize...

Click the right buttcm%r [ﬂ! Jousg 51 ah empty seat of any panel of
tools and choose item Customize.



3aTeM yCTaHOBUTE yKasaTerb
MbILLW HA BEPTUKATbHbIN
pasgenutenb naHenu
MHCTPYMEHTOB UM Ha P TOYEK,
NOSABMBLLNXCSA CNeBa OT Ha3BaHUS
NnaHenm MHCTPYMEHTOB, W
nepertawuTe naHenb B noboe
HY>XHO€ MEeCTO 3KpaHa.

\=.) Y Then establish the index of the mouse on a vertical divider of the panel
/4 of tools or on a number of the points which have appeared to the left of
the name of the panel of tools, and drag the panel in any necessary

place of the screen.




HeMHOro noTpeHmMpoBaBLUUCH,
Bbl OOHApPYXXUTe, YTO BCE

NaHeJ1IN NHCTPYMEHTOB MOXHO

[eY=Teinle1nl0) HOU CTDOK
b Customize Toolbar @

l Available toolbar buttons: Curmrent toolbar buttons:

| | |
N -~ /_4.:5"_( ~ : :
Mail Ji CnpaeouyHme Mmatepuana
| Discuss & Size
. e ZE
W ;. ~aad i =
db Cut Separator
L <- Re
& ‘] Copy @ Full Screen ¥
— Move Up
4 Paste Folders 3
(=1
, A -
‘] H B . s i, s 3
< > < >
Text options: |Selective text on right v
Icon options: |Large icons ~

1
I‘I'dVIﬂg d litue udlirieaq, you Wil , uidt dil uie panel O1 100IsS CcdIl arrange
in one line.




Tak 4To aKCNepUMEHTUPYUTE B

~rRNA \/INMNRNMKCATBYE.

. rF
v 27 I )i

@{ = Lo ;K &v Folders

o0 experiment in ne plieasure.




3arnosiHaeM, QpopMabl.

We fill, forms.




{1 B anoxy "Web-cpeaHeBekoBbs"
(T.e. B 1993 roay) Web-
CTPaHULbl ObININ OObIYHLIMY
cTpaHuuamm Ang npocMoTpa.

During an epoch of "Web-Middle Ages" (i.e. in 1993) Web-pages
were usual pages for viewing.



" [TOoCKOsbKY 9TO ObINO CMULLKOM
i NPOCTO U HEe NMPUHOCKIO

O0NbLLUOro yaoBOSIbCTBUS,
n3oopenn Web-dpopmbi.

: 4} | As it was too simple and did not bring great pleasure, have invented

Web-forms.



)1 ®@opma - 3TO He4YTo Hanogobue
- 1| ByMadKHbIX BriaHKoB ¢ rpadhamu,
{-_1 KOTOpble Bbl MOXeTe 3anofHUTb
n oTocnaTb.

: 4} | The form is something like paper forms with columns which you can fill
and send.



1T 4 Benble NPSMOYronbHble POPMbI

{1 ABNSAOTCA TEKCTOBLIMM NONAMMU,

.l B KOTOpbIE MOXHO BBECTY

Y # kKakne-nmbo AaHHble, Hanprmep

" f  1MS M agpec aNeKTPOHHOM
NoyYThl.

n 4’ | White rectangular forms are text fields into which it is possible to enter
| any data, for example a name and an e-mail address.




o
G m ;J l I Create a Google Account - Gmail

by Google BETA
<

~ ~
Y < N

Get your invitation code

To sign up, enter your mobile phone number below. We'll send you a text message with an invitation code to create
your account. If you've already received a code, skip to step two!

Location: Australia v

Mobile phone number:

Save my number for use with future Google Mobile services, such as secure
password recovery and SMS alerts.* Learn more

Type the charactars you s22 in the picturs below.

QLR

Send code




ManeHbKkmne KBagpaTHble NoNsA
Ha3bIBAlOTCA o/ia208bIMU
KHOMKamu.

Save my number for use with future Google Mobile services, such as secure
password recovery and SMS alerts.* Learn more

Type the characters you 22 in the picturs below.

Small square fields refer to checkfields as buttons.




B HY>KHbIX N3 HUX (MOXHO gaxe
BO BCEX) YCTaHaBMNBAETCH
dona’kok.

In necessary from them (it is possible even in all) the tag is
established.




ManeHbkue Kpyrnble nong
Ha3bIBAKOTCA
rnepekrirodyamernsamu.

1. Kak Bul ouenuBaete pazgen "lognepxka” Ha cante komnanuu Nokia (no
aAecatubanncHon wkane)? (1=Kpaine HeynoeneTeoputensHo, 10=3amevarencHo)

1, KpaitHe 10,
HEeyAOBNeTBOPUTENLHO 2 3 4 5 6 7 g 9 3ameuarencHo

Small round fields refer to as switches.




OHM NoxoXxun Ha doraroBble
KHOMKW, HO, B OTNN4YmMe OT
nocneaHnx, Nnonb3oBaTesb
MOXET BblOpaTb TOMbLKO OOHY
ONUUIO U3 KaXKgou rpynnbl

nepekn4yartenen.

/ 4’ | They are similar on checkfield buttons, but, unlike the last, the user can
| choose only one option from each group of switches.




B qoopme nmeertcsa Takke OKHO
criucka, B KOTOPOM MOXHO
BbIOpaTb Ntodon 13

npegsaraemMbix NyHKTOB.

ant to:| <select an action> v

<select an action>
Sign up for MSN Internet Software

#| Compare pricing and offers for MSN

Find information for current MSN members

View dial-up access options
‘-‘Learn what features are available in MSN
Learn about e-mail options in MSN

Find MSN options outside the USA
Get storage with MSN Hotmail Plus
EEDD_OL' Learn more about parental controls

View the FAQ
Order an MSN 9 CD

urope & the Middle East

= | Dalmisms P ash) | Deleiins (Eemnch) | Mernsacl | Cinlend | Cean mrrn=

In the form of is available also a window of the list in which it is
possible to choose any of offered items.




Yalle Bcero B Cnucke
coaepxunTcs bonbLue

| aNemMeHToB, YeM NomeLLaeTcs B
-% ero OkHe, MO3TOMY AS11 MOMHOTO
" NpocMoTpa CNUCOK Haao
NPOKPYTUTL BBEPX UMW BHU3.

| AR
(P =

/ RONE More often in the list contains more elements, than is located in its
‘:_*:.1_" window, therefore for full viewing the list should be scrolled upwards or
Q g downwards.



-4 OObl4yHO BbIOMPAIOT TOMBKO
. { OVH BapWaHT, HO B HEKOTOPbIX
/-1 okHax cnucka gonyckaeTcs
BbIOOP Cpa3y HECKOMNbKUX
311EMEHTOB.

Usually choose only one variant, but in some windows of the list the
choice at once several elements is supposed.




-4 [locne otnpaBkn popMbl ee
.} 06paboTKOM 1 MHTEepnpeTauuen
Y [NaHHbIX 3aHUMaeTCS

h ] nekntounTensHo Web-cepsep.

: 4} | After sending the form by its processing and interpretation of data the

Web-server is engaged exclusively.



Ha HekoTopbix Web-cTpaHunuyax
pa3MeLLEeHbl ToUCKO8bIe
arieMeHmeI.

On some Web-pages search elements are placed.




[1lo cyTn, 3TO ynpoLleHHbIE
OAHOCTPOYHbIE POPMbI; B HUX

.4 BBOAATCSH KMOYEBbIE CMOBA, MO
.~} KOTOpPbIM U NPOBOANTCS MOUCK.

As a matter of fact, it is the simplified one-line forms; keywords on
which search is spent are entered into them.



j [Mocne 3Toro, B 3aBUCUMOCTU OT
Obpoy3epa, nnobo
BOCMONb3yNTECb KHOMKOW
OTMNPaBKU, NMMOO HaAXMUTE
knasuwy <Enter>, 4TOOBLI
OTNpaBUTb CrioBa aJ19 NouCcKa
Ha cepBep.

| AR
(P =

/ 4’ | After that, depending on a browser, or take advantage of the button of
| sending, or press a key <Enter> to send words for search on a server.



Hanpumep, Ha NOUCKOBOW
cTpaHuue Web-y3na Yandex
(Wwww. yandex. ru) umeetcs

none, B KOTOPOE BBOAUTCA

ANDAN 1IA114 AhNnAann

Andex =

Hau,ueTcg BCE Mpumep: ¢ 11t GENCTEYIOWMUI BYNKaH paCLMPEHHbIit nouck  [+]

For example, on search page of Web-unit Yandex (www. yandex. ru)
there is a field into which the word or a phrase is entered.




% [locne HaxaTna knaBULLIK
|| <Enter> unu Wwen4ka Ha KHOrKe
.4 Hantu HaumHaeTcs npouecc no
e ncKa




llpuomkpoem 3asecy
ceKkpemHocmu

Let's slightly open a veil of privacy




[1pn 3anonHeHnn Popmbl Ha
Web-cTpaHuLe MoXeT
BO3HUKHYTb HEODOXOOAMMOCTb
npeagocTaBuUTb
KOHOUAeHUNanNbHYHo
MHEOpPMALUIO - HAaNnpUMep,
HOMep Ballen KpeanTHOW

KapTO4KN.

At filling the form on Web-page there can be a necessity to give the
confidential information - for example, number of your credit card.




[lyCTb Bac 3TO He BOJIHYET.

Let it does not excite you.




CoBpeMeHHble Dpoy3epbl
CNOCOOHbI LUndopoBaTh

Modern browsers are capable to cipher the information which you
exchange with a safe Web-server.




‘I’ﬁ B Netscape, Mozilla n Internet Explorer
{4 Ons npegynpexaeHyst nonb3oBaTtenen
Y 06 0nacHOCTY NPOM3BOANMbIX UMM
- ¥ IefiCTBUIM UCTIONb3YIOTCA creuunarnbHble
3/-.-¥ OKHa, KOTOpble NOSIBMSATCSA Ha 3KpaHe,
U5 Hanpumep, npu nepexoae oT paboTbl C
LUIMCPPOBAHHBIMU AaHHBLIMU K
HelwndpoBaHHbIM.

b4 "___'_-;)‘
(P =

In Netscape, Mozilla and Internet Explorer for the prevention of users of
danger of actions made by them special windows which appear on the screen
{I'] are used, for example, at transition from work with secure data to non-secure.



B OOnbLUMHCTBE U3 TaKUX
OKOLLEK eCTb norie, ycTaHOBUB
¢praxkok B KOTOPOM Bbil
-1 cooblmTe Npo rpaMme, YTO6L!
{7v1  oHa bonblue He Becrnokouna

BaC NOgoOOHbIMU
npenynpexneHnsamu.

: 4 | In the majority of such windows there is a field, having established in
| which you inform a tag about gram that it any more did not disturb you
similar warnings.




Cniacu u coxpaHu!

Rescue and keep!




OuyeHb YacTto Ha Web-
}* { CTpaHuLUax Bbl OGHapyxuBaeTe
-1 MIHpbopMaLMIO, KOTOPYHO XOTENu

/ 4’ | Very often on Web-pages you the information which would like with to
| store for the reference to it in the further.




VIHorga MHTepeCcHOU KaXXeTcs
BcA Web-cTpaHuua, pucyHok
NNn 4YTO-HMOYAOb OpYyroe.

Sometimes interesting all Web-page, figure or seems to something
another.




K cyacTblo, npoueaypa
COXpaHEeHUA O4eHb NpPocCTa.

Fortunately, procedure of preservation is very simple.




[1pn coxpaHeHunn Web-

I+ 4 cTpaHuLbl HEOBXOANMO PELLNTB,
“~1  HY)XHO N BaM COXPaHATb
TOJIbKO HaXoOALWMNCA Ha
CTpaHuuUe TEKCT UK Bce
coaepXMmoe CTpaHuLbl B
doopmaTte HTML BmecTe €

KogamMuy doopmMaTUpoBaHUA.

At preservation of Web-page it is necessary to solve, whether it is
necessary for you to keep only a text being on page or all contents of
page in format HTML together with codes of formatting




Kpome Toro, Bbl MOXeTe
COXPaHUTb rpadPUyeCcKyio

¥ MHOpMaLWIo, coaepKaLLytoCs

Ha Web-cTpaHue.

Besides you can keep the graphic information containing on
Web-page.



UTOObI COXpaHUTb TEKYLLIYIO
Web-cTpaHuuy B oTAENbHOM
daune, BbibepnTe KomaHay
File™ Save as
(Pann=>CoxpaHnTb Kak).

4" /W To keep current Web-page in a separate file, choose command File=>
| Save as




OTKpoeTcs cTaHOapTHOoE
~-4 OmanoroBoe OKHO COXpaHeHUs
“ { dpanna (B Internet Explorer 6.0
| OHO Ha3biBaeTcsa Save Web

Page (CoxpaHeHune BeD-
CTpaHuLbl), B KOTOPOM HY>XHO

3agaTtb MMA paunna.

The standard dialogue window of preservation of a file in Internet
Explorer 6.0 it refers to Save Web Page in which it is necessary to set
a name of a file will open.




[lanee cnenyert ykasaTth, B
KakomMm doopmaTe Bbl XOTENN Obl
COXPaHUTb CTPaHULLY.

| Further it is necessary to specify, in what format you would like to keep
page.




[na aToro us

- packpblBatoLLerocs cnvcka Type

2.4 (Tun dpaiina) BbiGepuTe,
HanpUmep, onLuio

For this purpose from a revealing list (Type of a file) choose, for
example, an option




TekcToBbI pann Ans

7§ COXpaHeHs1 TOMNbKO TEKCTOBO
/-1 mMHdopmMaumm c HebonbLIMMK
NnpYMeYaHUsSMU B TeX MecTax,
rae BCTPEYaroTCst KapTUHKM.

Text file for preservation only the text information with small notes in
those places where there are pictures.




I+ 4 BbibepuTte nyHKT Be6-cTpaHuua,
Tornbko HTML unn Be6b-
CTpaHuua, NOSIHOCTLIO (B
Internet Explorer), 4ToObLI

k] COXpaHWUTb BCIO CTpaHULy B
|- { Buae daiina dhopmara HTML.

/ 4’ | Choose item the Web-page, only HTML or the Web-page, completely
| Y (in Internet Explorer) to keep all page in the form of a file of format
HTML.




[loTOM wenkHuTe Ha kHonke OK
mnmn CoxpaHuTb.

Then click on button OK or To keep.




-3 Ecnu Heobxoanmo CoXpaHuUTb

| n3oBpaxeHune, NpMBEAEHHOE Ha

. CTpaHuue, LENKHUTE Ha HeM
NpaBoy KHOMKOW MbILLMW.

/ 4} | If it is necessary to keep the image brought on page, click on it the right
button of the mouse.




“ { V13 NosBMBLLEroCs KOHTEKCTHOTO
54 MEHIO BbIOEPUTE MYHKT
CoXpaHUTb PUCYHOK KakK.

From the appeared contextual menu choose item To keep figure as.




ﬁ B nosBuBLLEMCSH OMANIOroOBOM
-4 okHe Save As (1nn CoxpaHuTb
{ KakK) yKaxknte narky, B KOTOPOW
HeoOX0ANMO COXPaHUTL
rpaguyecknn aunrn, ero Tmn wu
Y- 1 HasBaHue, a 3aTeM LUEenKHUTE
/-1 Ha kHonke OK nnn CoxpaHuTb.

P

/ 4 i In appeared dialogue window Save As (or To keep as) specify a folder
| in which it is necessary to keep a graphic file, its type and the name,
and then click on button OK or To keep.



[TpmeyaHne 06 aBTOPCKUX
npaBax.

The note on copyrights.




Bonpekn pacnpocTtpaHeHHOMY
MHeHUIo, NnodTn Bce Web-
CTpaHuLbl, Kak 1 BCce apyroe,
YyTO Haxogoutcsd B Internet,
OXPaHAKTCA aBTOPCKUMW

npaBaMMm.

Contrary to a popular belief, almost all Web-pages, as well as all
another, that is in Internet, are protected by copyrights.




Ecnun Bbl ckKonMpoBanu KapTUHKY
J< {unm TekcT ¢ Web-cTpaHuLbl, 3TO
.1 ellle He 3HaYWT, YTO Tenepb Bbl
4731 MOXeTe nonb3oBaTbCs UM MO
CBOEMY YCMOTPEHMIO.

If you have copied a picture or the text from Web-page, it does not
mean yet, that now you can use it at own discretion.




[lepea NOBTOPHbLIM
NCMONb30BaHMEM TEKCTa UNu
) KapTUHKW NOLLNNTE MO
.. § 3NEeKTPOHHOM MoYTe CoobLyeHne
1 x03auHy TOro yana, rae Bbl UX

oOHapyxunw.

/ 4’ | Before a reuse of the text or a picture send by e-mail the message to
| the owner of that unit where you have found out them.




Ecnun agpec Ha cTpaHuue He
-3 yKasaH, nowwnuite coobLlieHune
. ¥no agpecy webmaster@domain.
.4 com, rge domain. com - 3T0 UM
h | OOMeHa, KoTopoe SIBMsieTCS
|- { yacTbio URL Web-cTpaHupi.

If the address on page is not specified, send the message to the
address of webmaster@domain. com where domain. com is a name of
the domain which is part URL of Web-page.




.. Jlec py6sim - wienku nemsim

You can't make an omelet without breaking eggs




B TeyeHue roga nocre
nosasneHusa Web-bpoy3epos B
HUX He paboTann KomMmaHabl

neyaTu.

Within a year after occurrence of Web-browsers print commands did
not work.




K cyacTtblo, NporpaMmMucCThbl
MOHANN, YTO HOPMAarbHbIM
noaam (Takmm Kak Mbl C BaMK)
BPEMSA OT BPEMEHMU HYXKHO
pacrnevaTbiBaTb HEKOTOPbIE

Web-cTpaHunubil.

Fortunately, programmers have come to understand, that normal
people from time to time need to print a Web-pages.




Tak 4To Tenepb KOMaHALI
neyaTtn B bpoysepax paboTatoT
HOpManbLHO.

So now print commands in browsers work normally.




j [na Toro 4toObI pacnevyaTaTtb
-4 CTpaHuuy, LWENKHNTE Ha KHOMKeE
Print ([NeyaTb) naHenu
MHCTPYMEHTOB, NIMOO HaXXMUTE
vy knasuwm <Ctrl+P>, nnbo
1. 4 BbInonHuTe komaHay File=>Print
7 (Gann?Mevathb).

——

| AR
(P =

To print out page, click on button Print of the panel of tools, or press
keys <Ctrl+P>, or execute command File=>Print (Pann*lleyatn).



-4 Ha nogrotoBKy cTpaHuLbl K

I neyatn (nepecdpopmaTmpoBaHue)

.4 yXOOUT HEKOTOPOE BPEMs, TakK
4yTO OyabTE TEPNENMBLI.

: 4} | On preparation of page for printing (Format for Printing) some time so

be patient leaves.



K cyacTtbto, Bce bpoy3epbl
BbIBOOAT HA 9KpaH UHAMKATOP
Xoga npouecca, No KOTopomy

BWOHO, Kak nayT gena.

/ 4} | Fortunately, all browsers display the indicator of a course of process on
which it is visible as there are business.




Ecnu Ha pacnevatbiBaemMon BaMu
ﬁ CTpaHuLEe UCMonb3yTca dpermbl
(C NMOMOLLIbIO KOTOPbIX OKHO
pasgensieTcd Ha HeCKOMbKO
nogoodbnacren, KOTopble MOXHO
NPOKpy4nBaTb U OOHOBMATL
He3aBUCUMO OT OCTaribHOW YacTu
CTpaHu LbI),

P

: 4 | If on page printed out by you frames (by means of which the window is
| divided into some sub areas which can be scrolled and updated
irrespective of other part of page)



TO nepen nevyaTtbio Heobxoanmo
LLIENKHYTb HA YacTu CTPpaHuLbl,
KOTOpYyto TpebyeTcsa pacrnedaraTb.

before a print} it is necessary to click on a part of page which is
required to be printed out are used.



I 4 B NpoTMBHOM cryyae Ha Bymare
-4 BrorHe MoOXeT oKa3aTbCH
) caMbin ONMXKHUN Kpan

*.-& CTpaHMLbl, COAEPXKALLM TOMBKO
| 3arofmioBOK U HECKOJ1IbKO KHOIMOK.

Otherwise on a paper there can be the nearest edge of page
containing only heading and some buttons.




au, Cookie, pyku rpoyb om
MO€E20 KOMrbromepa

Hey, Cookie, hands off my computer




Z /% YTOObI ynpocTUTh Bally paboty
B WariOroBOM PEXnMe,

{1 paspaboTunkn Web-6poy3epos
-} 130 Bpenu TN cnewumanbHbIX
COOOLLEHNN, KOTOPbIE
no3sondaT Web-yany "y3HaTb"
BaC Npv NOBTOP HOM €ro

noceLeHunn.

: 4 | To simplify your work in a dialogue mode, developers of Web-browsers
| from went type of special messages which allow Web-unit "to learn”
you at repetition Hom its visiting.




bpoy3epbl COXPaHAKT 3TH
|-\ [OaHHble, KOTOPbIE Ha3bIBaKOT
" cookie, Ha BaLleM COBCTBEHHOM
9} KOMMblOTEpE.

Browsers are kept by these data who name cookie, on your own
computer.




Ob6bI4HO dpaunbl cookie
COBepLLUEHHO Oe3BpeaHbl K
OaXke rnonesHbl.

Usually files cookie are absolutely harmless and even are useful.
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N;j Hanpumep, npu nocelueHnn Web-y3na
;-4 no BPOHMPOBaHMIO aBUaBNNETOB
¥ cookie ucnonbayTcsa AN Toro, YTobbl
¥ OTOenUTb JaHHble O pence, Ha KOTOPbI
/.4 Bbl GPOHMpYETE MeCTa, OT PENCOB, Ha
KOTOpble OAHOBPEMEHHO C BaMy
OPOHMPYIOT MECTA ApYyrme

MNOoJyib30BAaTEIlN.

P =

For example, at visiting Web-unit on booking air tickets cookie data
about flight on which you reserve places, from flights on which
simultaneously with you reserve places other users are used to
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Cookie ®ann OTKpbITb



Ho, ¢ Apyron CTOpOHLI, CookKie
MOIYT CTaTb U UICTOYHNKOM
HEKOTOPbLIX Npobnem.

But, on the other hand, cookie can become and a source of some
problems.




[lpeanonoXxum, Bbl
BOCMOJb30Banncb KpeanTHOW
“ { KapTo4KoW AN NOKYMKU Yero-
-1 nn6o Ha Web-yane, v 3TOT y3en
"] Bocnonb3aosancs cookie ans
-4 Toro, 4yToBbI 3aMOMHUTL HO Mep
7 BaLLel KapTOUKN.

: 4 | Let's assume, you have taken advantage of a credit card for purchase
)Y by something on Web-unit, and this unit has taken advantage cookie to
‘ remember but measures of your card.




/-4 Tak BOT, eCcnn Bbl 3aHMManNuch
i* 4 aTum Ha paboTe U nocre Bac 3a
|- 170T e KoMNbIOTEP CAANTCS KTO-
.} TO pyron 1 nonagaeT Ha TOT Xe
/-4 y3en, TO eMy, BEpOSITHO,
yOacTcsa caenartb NOKYMKW,
BOCMOJ/b30BaBLUUCH Ballewn
KpeaAUTHOWU KapTOYKOMN.

: 4 | And so, if you were engaged in it on work and after you someone sits
5° . down to the same computer another and gets on the same unit to it,
i1 possibly, it will be possible to do shopping, having taken advantage of




BoTt Tak!

Here so!




[ lonb3oBaTtenu Internet nmetor
pa3HOe MHeHUne o cookie.

Users Internet have different opinion about cookie.




HeKkoTopble NPOCTO HE
obpallatoT Ha HUX HUKaKOro
BHUMAHWUA, a Opyrne cymtaroT
9Ty TEXHONOIMIO rpPyodbLIM
HapyLleHnem
KOHQUAOEHLUMNANbHOCTMN.

/ 4’ | The some people simply do not pay to them any attention, and others
| consider this technology as rough infringement of confidentiality.




OKoH4aTernbHoe pelleHne 3a
BaMMW.

The final decision for you.




Bonpeku cnyxam, dpannbil
cookie He natoT BO3MOXXHOCTU
npoynTaTb OpYyrne AaHHble C

BaLLIEro XeCTKOro gmcka v

HUKOUM O0Opa3oM He MOryT

MCNOPTUTb dpannsil,
XpaHALLMeca Ha KoMnbloTepe
nonb3oBarteng.

Contrary to hearings, files cookie do not give an opportunity to read
through other data from your hard disk and cannot spoil files at all,
stored on a computer of the user.




OHK Bcero nuuib cobumpatoT
MHAOPMALNIO, KOTOPYIO
npenoctaBnaeT nm bpoysep.

They only collect the information which gives to them a browser.




Internet Explorer, Netscape n
Mozilla no3BonaroT
KOHTPONMPOBaTb NpoLiecc
XpaHeHna cookie Ha Ballem

KOMMNbIOTEPE.

4" /¥ Internet Explorer, Netscape and Mozilla allow to supervise process of
| storage cookie on your computer.




B Internet Explorer 6.0.
OTKpouTe AnaroroBoe OKHO
CBounctBa o0bo3peBaTens
(Internet Options), BbINONHUB
komaHay Cepsuc*CBouncTBa
obo3peBatens (Tools*Internet

Options).

In Internet Explorer 6.0. Open a dialogue window of Property of an
observer (Internet Options), executed command Cepsuc*Csoncrea of
an observer (Tools*Internet Options).




Internet Options

General | Security | Privacy | Content | Connections | Programs || Advanced | Ll-len KH M Te H a

Home page
E i You can change which page to use for your home page. | B K J-I a K e
Address: [ qoog ﬂ

[ Use Curent | [ Use Defautt | [ Use Blank | KOHd)M.D,eHL',VIaan

Temporary Intemet files .
7 Pages you view on the Intemet are stored in a special folder O CT b P rl V a C
@ Y forquick viewing later. .

[Delete Cookies... [ Delete Files... } [ Settings...

History

~ The History folder contains links to pages you've visited, for
quick access to recently viewed pages.

Days to keep pages in history: 20 < | | Clear History

[ Colors... J [ Fonts... ] [Languages... ] [Accgssibility...]

[ OK ][ Cancel ]

Click on Tab Confidentiality (Privacy)




LLlenkHUTe Ha KHonkKe
NononHutenbHo (Advanced),
YTOObI OTKPbITb AMNANOroBoe

OKHO [lononHuTenbHbIE
napameTpbil
s KOHQUAOEHUMANbHOCTH
/1 (Advanced Privacy Settings).

/ 4’ \' Click on the button In addition (Advanced) to open a dialogue window
| Additional parameters of confidentiality (Advanced Privacy Settings).




) -4 Tlo ymon4aHutio Internet Explorer 6.0
ﬂf\_ﬁ BeaeT cebs Mo OTHOLLEHMIO K parinam
cookie JoCTaToYHO CTPOro U
paspellaeT ncnosfib3oBaTb cookie,
Nnosly4YeHHbIe TONMbKO C cepBepa, C
KOTOPbIM Bbl KOHTAKTUPOBAIn, a He COo
'] cTopoHHUx cepBepoB (Web-cepBepi,
OoTNin4atloLnecs oT TOro, KOTOPbLIN
(7 © XpaHUT cookie Ha BaLlem
/ By default Internet Qpl}grl;lrl%.l-oo bE?aQe?' relation to files cookie
WL/ strictly enough and allows to use cookie, received only from a server to

which you contacted, instead of from foreign servers (the Web-servers
differing what stores cookie on your computer).



CTopoHHUE cepBepbl 0ObIYHO
ABMSAOTCS MOCTaBLUMKaAMMW
peknambl 1 "OocTaBy4nx”

BCMNJbIBAKOLLMX OOBbABNEHUN.

/ 4 /W Foreign servers usually are suppliers of advertising and "goctasyumnx"
emerging announcements.




Bbl MOXXeTe CaMOCTOATENBLHO

= ynpaBnATb pannamm cookie,

_ 4 ycTaHOBMB chnaxok B nomne onuum

' [NepeKkpbITb aBTOMATUYECKYIO
00paboTKy dpannoB cookie
(Override Automatic Cookie

Handling) B ananoroBom okHe

[lononHuTenbHblEe NapaMeTpsbl

KOHdOMaEeHUNaNbHOCTMW.

4 | You can independently operate files cookie, having established a tag in a field
of an option To block automatic processing files cookie (Override Automatic
{I'l Cookie Handling) in a dialogue window Additional parameters of confidentiality.




YcTaHOBUTE NepekntoyaTens B
3TOM OKHEe B O4HO 13 MO Nneu
Ka)XOou U3 yKa3aHHbIX HMXe

rpynn onuumn.

Establish the switch in this window in one of on pour each of the
options specified below groups.



Web-6poy3ep, cookie u ebl

A Web-browser, cookie and you




OcHOBHbIe cookie.

The cores cookie.




JTO paunbl, KOTOpbIE

.} nocTynaT HenoCpPeaCTBEHHO C
.4 npocmatpusaemon Bamun Web-
s CTpaHuLbI.

: 4’ | These are files which act directly from Web-page You are looking at.




;1 OBbLIYHO OHM UCMONbL3YIOTCA AN
<1 TOro, 4to 6bl 3ANOMHUTL
flaHHble Nofb30BaTens,
3aperMcTpMpoBaBLLErocs Ha
naHHom Web-yane.

Usually they are used what to remember data of the user who has
registered on the given Web-unit.




{1 lns nonb3oBatens aTo yOoo6Ho,

| TaK KaKk eMy He Hy>HO ByaeT
KaXkablX pa3 BBOOUTb UMS
nonb3oBaTens u naporb.

It is convenient for the user, as it will not need to enter each time a
name of the user and the password.




Mo>HO BblOpaTb OQHY U3
crnegyowmx onumm:
MpuHumaTtb (Accept),
bnokunpoBatb (Block) nnu

Choose), XOTS nocrneaHee Bam
7 4 ObICTPO HaOOECT.

: 4 ; It is possible to choose one of following options: To accept (Accept),
|~ \! To block (Block) or To request (Be prompted to Choose) though the
) il last will quickly bother you.




10 HekoTopble y3nbl MOTryT
/-1 XpaHUTb TpY 1 BornbLue dannos
AN cookie Ha CTpaHuLLy.

Some units can store three and more files cookie on page.




CTtopoHHUe cookie.

Foreign cookie.




;1 Bnagenbupl MHorux Web-yanos
" §{ 3aKnwoyatoT cneumanbHble 40
/- 1roBOpa C KOMMaHKSAMM, KOTOPbIE
477 3aHMMaloTCs pasMeLLeHneM
peKnambl Ha HUX.

Owners of many Web-units conclude special up to a dialect with the
companies which are engaged in accommodation of advertising on
them.




MIMEHHO 3TN KOMMaHUN MOTYT
"3anycTuTb cookie Ha BaLl
KOMMNbIOTEP C Lernbio cobopa

OAHHbIX 01151 NpoBeAeHUs
MapKeTUHra.

These companies can "start" cookie on your computer with the
purpose of data gathering for carrying out of marketing.




B aTOM rpynne ectb Te Xe
camMmble onuumn, YTto N B

npeabiayLen.

In this group there are same options, as in previous.




CTopoHHME cookie NMonesHbl
TONbKO ANA peknaMHbIX
KOMMaHUN, MO3TOMY Mbl HE
BUOAUM HUKAKOWU NPUYUHBLI ONA
NX paspeLleHuns.

/ \ 4 /W Foreign cookie are useful only to the advertising companies, therefore
| we do not see any reason for their sanction.




Bcerga paspellatb ceaHCcOoBble
cookie.

Always to resolve session cookie.




" YCTaHOBMB (PrakoK B Mnose 31ou

-y onumu, BBl paspeluaeTe
Mcnosnib3oBaHMe BCex

CeaHCOBbIX pbannoB cookie.

: 4} | Having established a tag in a field of this option, you resolve use of all

session files cookie.



ITOT TUN cookie-dpannos
ncrnonb3yeTcs ans
OTCreXxXmBaHUAa eaNHNYHbIX
CrlydaeB MnoceLleHnst Bamu

kKaknx-nnmoo Web-y3nos.

/ 4’ | This type of cookie-files is used for tracking single instances of visiting
| of any Web-units by you.




Takue cookie yacTto
ncnonb3ytorca Web-y3namu,
4 3aHUMaoLLMMKCA NpoaaxXamu
(Kak, Hanpumep, Amazon.com).

/ 4} | Such cookie are often used by the Web-units, engaged sales (as, for
example, Amazon.com).




UcTtopua? Kakasa ncropua?

History? What history?




BoNbLUMHCTBO rpadunyecKkmnx
Opoy3poB MMEET eLle 0aHO
norne3Hoe CBOUCTBO Noa
Ha3BaHWEM UCMOPUS.

: 4} | The majority of graphic browsers have one more useful property under
the name history.




Pagom ¢ nonem, B KOTOpPOE
BBOOUTCA afpec CTpaHULbI,
pacnonaraeTcs KHomnka
pacKpbIBalOLLLErocsi criucka, B
. 3] KOTOpOM oTOobpaxeHbl agpeca
{'- {paHee noceLLaBLUNXCS CTPaHWL,.

/ 4’ | Near to a field into which the address of page is entered, the button of
| a revealing list in which addresses before visited pages are displayed
settles down.




/=¥ HekoTopble nogn cnpallmBatoT, Kakum
A0 4 06pa3oM yaanuTb coaepKMMoe Cnmcka,
©.4 TMOCKOMNbKY B MUHYTbI paccnabneHus
.4 BmecTo agpeca http://www.disney.com

/-] HenocnyLHble nanbLbl BBOAST YTO-
HMbyab Hanogobwue
http://www.hot-xxx-babes.com
(cornacuTecb, Takad bega MOXeT
NPUKIMIOYNTBLCA C KaXabIM).

Some people ask how to remove contents of the list as instead of the
address http://www.disney.com disobedient fingers enter something
into minutes of a relaxation like http://www.hot-xxx-babes.com (will

agree, such trouble can happen to everyone).




[TockonbKy AaHHas npocbba
3By4arna o4eHb 4acTo, TO Mbl

¥ pelunu B AeTansix 03HaKOMUTb

BacC C npouenypomn.

: 4} | As the given request sounded very often we have decided to acquaint

in details you with procedure.



Internet Explorer.

Internet Explorer.




Bbibepute komaHay MEHIO
Buo*CBonctBa obo3peBaTens
mnmn Cepsuc CBoncTBa
obo3peBaTens, nepenante Ha
Bknaaky ObLme n B rpynne
JKypHan LWenkHUTe Ha KHormKe

Ouunctutb (Clear History).

Choose a command of menu Tools =>internet options, pass on Tab
General and in group Magazine click on the button To clear (Clear
History).




¢4 Internet Options
General | Security || Privacy | Content | Connections | Programs | Advanced

Home page
‘ E 5 You can change which page to use for your home page.

Address: D google
| UseCument | [ Use Defaut | | Use Blank

Temporary Intemet files
7 Pages you view on the Intemet are stored in a special folder

\ @Y forquick viewing later.
[Delete Cooki_es...] [ Delete Files... ] [ Settings...
History
The History folder contains links to pages you've visited, for
quick access to recently viewed pages.
Days to keep pages in history: 20 < | | Clear History
[ Colors... ] [ Fonts... ] [ Languages... ] [Accgssibil‘rt','... ]

| 0K |[ Cancel ]

' Ha 3anpoc o

noaTBepXxae
HUU

onepauunn

OTBETbTE
LLLeNYKOM Ha
kHonke OK.

Inquiry about acknowledgement of operation answer with click on
button OK.



A Tenepb cnoem, CTaHUyeM U
nod6ontaem 8 Web

And now we shall sing, we shall dance and we shall chat in Web




Web-cTpaHuubl ¢ 00blYHBIMU
KapTUHKaMN yxxe 6e3HagexHo
ycTapenw.

Web-pages with usual pictures have already hopelessly become
outdated.




CoBpemeHHble Web-cTpaHuLbl
NOSMKHbI UMETb KapTUHKM,
-1 KoTopble MOKT Y TaHLYHOT, UK
.} COOBLLEHNS, KOTOPbIE MUTAIOT Y
¥ [ABMrarloTcs no cTpaHuue, unu
]| BCTPOEHHbIE BUAEOKIMIbI, UMK
I'~4 OHW BOOGLLE AOMKHLI YMETL
cbirpaTb C BaMu B LLAXMaThl.

Modern Web-pages should have pictures which sing and dance, or
messages which blink and move on page, or the built in videoclips, or
they in general should be able to play with you a chess.




C kaxxgbiMm mecauem B Web
NOSABNAKOTCS BCE HOBbIE U
HOBble BUObI MHOpMaLUUK,
KOTOPYIO Bpoy3epbl AOSTKHbI
YMETb NoaaepKXnBaTh.

With each month in Web there are all new and new kinds of the
information which browsers should be able to support.




[1na aTOro ncnonb3yTCA
ynpaBnsawLmne sfieMeHmal
ActiveX, npeacrasnawoLume

cobon pasHOBUAHOCTb
nporpamMmm-gonosIHEHUN.

/ 4’ | For this purpose the operating elements ActiveX representing a version
| of programs-additions are used.




UT0 Xe bpoy3ep OosmKeH
.\ [genaTb CO BCEMM 3TUMMW
.4 HOBbLIMU BUAAMW VHGOPMaLUM
Ha Web-cTpaHuue?

: 4’ | What should the browser do with all these new kinds of the information
on Web-page?




[1na ee ob6paboTKn
npeaHasHavyeHbl NporpamMmbl-
OOMNOJIHEHUSA, KOTOPbIE
HETPYOHO NPUodbpecTn n
"MPUKNENUTL" K CBOEMY
Netscape, Mozilla nunm Internet
Explorer.

Programs-additions which are easy for getting and "pasting" to the
Netscape also are intended for its processing, Mozilla or Internet
Explorer.




[lapag nporpamm-
nononHeHun Parade of
programs-additions




[ lepeyncneHbl HEKOTOPbIE
nosie3Hble nporpamMmmbl-
OOMNOJTHEHHAS.

blome useful programs-added are listed.




RealPlayer.

RealPlayer.




Bocnpon3BoauT nomokKossie
3BYKOBbIe (pausibl N0 Mepe ux
3arpysku (6onbLUMHCTBO
nporpamMmm crnocobHo Ha4aTb
BOCMNpOn3BeaeHNE TOMNbKO
nocne Toro, Kak goau’s

3arpy3uTcs NonHOCTLIO).

Reproduces streaming sound files in process of their loading (the
majority of programs is capable to begin reproduction only after the file
will be loaded completely).




" { BecnnaTHblit RealPlayer MOXHO
25 Nony4mMTb NO agpecy
http://www.real.com.

Free-of-charge RealPlayer it is possible to receive to the address of
http://www.real.com.




i ¢  TyT e Bbl Hangete bonee
{1 MowHble cpeacTaa, 3a KoTopble
| npuaertcs 3annaTUTb, a TaKKe
%  nepedvyeHb Web-y3noB, Ha

h ] KOTOPBIX CO AepaTcs 3ByKOBble
|- { dpainbl B popmate RealAudio.
There and then you will find more powerful means for which it is

necessary to pay, and also the list of Web-units on which with sound
files in format RealAudio keep.




/1 Cpegm Hawwmx niodumbix Web-

1T 4 yanos co 3ByKoBbIMU (hainamu
-4 crTout ynomsiHyTb National

Public Radio (www.npr.org) u
BBC (www.bbc.co. uk), roe

kA MOXHO CrywlaTb “>KuBbl€" Npo

|- { rpammbl paguocTaHummn BBC 24
yaca B CYTKMW.

Among our favourite Web-units with sound files it is necessary to
- mention National Public Radio (www.npr.org) and BBC (www.bbc.co.
i1 uk) where it is possible to listen "alive" about grams of radio station 24




QuickTime.

QuickTime.




-} BocnpoussoauT Buaeodanssl B
=9 npouecce 1x 3arpysku.

Reproduces videofiles during their loading.




[1aHHOEe cpeacTBO MOXHO HANTK
254 no agpecy www. apple.
com/quicktime/download.

The given means can be found to the address of www. apple.
com/quicktime/download.




&
>
©
S
X
T
O
£
p

Shockwave.




Bocnpowun3soguT ayano u
BUOoeodaunnbl, a Takke
pas3nnyHble TUMbI aHUMaLUN.

“../¥ Reproduces audio and videofiles, and also various types of animation.




" laHHOE CPeCTBO MOXHO HaNTK
o Nno agpecy
http://www.shockwave.com.

The given means can be found to the address of
http://www.shockwave.com.




Adobe Acrobat

Adobe Acrobat




i~ OtobpaxaeT Acrobat-cannbl
y, -1 IMEHHO B TakoM BuAe, B KakoMm

477 OHM Bbl N1 co3aaHbl aBTOPOM.

| o
P\

Displays Acrobat-files in such kind in what they are created by the
author.



MHoOXecTBO nones3Hbix Acrobat-
doannoB MOXHO HAUTKU NO
agpecy www.blanki.ru.

The set of useful Acrobat-files can be found to the address of
www.blanki.ru.




Camy nporpamMmmy Bbl HanageTte
no agpecy www.adobe.com.

You will find the program to the address of www.adobe.com.
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